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1. What is UnrealPolyEd (UPE)?

UnrealPolyEd (or UPE) is a program that allows creating complex 3D
brushes that model outdoor terrain in the Unreal engine. It primarily
targets the Unreal1 and the Unreal Tournament (UT) engine, which itself
lack support for creation of complex 3D brush geometry. Similar tools must
have been used by the original creators of Unreal, Unreal: Return to Na
Pali and Unreal Tournament. Notice the environment brush geometry in the
following example.

 Example: Glathriel Village in Unreal: Return to Na Pali

It is unclear how those brushes were originally created, because the official
editor released with the games (UnrealEd) does not directly support their

http://home.in.tum.de/~geisinge/sw/unreal/tools/UnrealPolyEd/shared/guide/images/unreal_rtnp_example.jpg


creation. UnrealPolyEd is an external tool that fills this gap. It is specifically
suitable to create 3D outdoor environment brushes for use in Unreal1 or
Unreal Tournament.

 

2. How does UnrealPolyEd work?

The easiest way to create a terrain in Unreal1 and Unreal Tournament is to
create a big subtractive brush that carves the walkable areas out of the
world. Details can then be subsequently added to that area. Since all solid
brushes need to be "closed" (i.e., they need to form a 3D object whose
surface does not contain any holes), a suitable terrain brush needs to
consist of the ground (forming the terrain itself), the walls (typically
mountain-like shapes) and the ceiling (typically sky).

The sides of a brush are made up of polygons. Each polygon can have a
texture assigned that determines the visual representation of the surface.
The simplest case is to build the terrain brush out of triangles. This has the
advantage that no degenerated faces can be produced. Degenerated means
that the nodes the polygon is defined by (also called vertexes) are not
located on a plane. Degenerated surfaces may cause rendering and clipping
issues are runtime. In order to prevent such problems, we use triangles
(i.e., polygons with three nodes) to build terrain brushes. A polygon with
more than three nodes can be degenerated, but a polygon (triangle) with
exactly three nodes is never really degenerated. Notice however that all
three nodes of a polygon might be located on a line and hence the polygon
not being rendered. However, this is typically easy to spot.

The most important part of a terrain is the ground, because this is the
surface that the player will interact with. The walls are there to prevent the
player from leaving the map and the sky closes the map on the top. Of
course the sky should be made high enough such that the other
geometrical elements of the terrain, such as mountains and valleys, fit well
underneath it.

UnrealPolyEd allows to precisely model the coordinates of all nodes that
make up a polygon. As explained above, every polygon (triangle) consists
of three nodes. Neighboring polygons typically share a common edge (i.e.,
two of their nodes are the same). Using this simple principle, the grid of
neighboring polygons forms a brush that is closed in itself. Just like patches
that are stitched together to form a soccer ball, polygons are used in
UnrealPolyEd to form a large-scale hull inside which the player will be
walking.

The following sections first explain the UnrealPolyEd windows and then list
typical tasks. It is recommended to read the sections in order to get the
full picture. However, if you want to directly check for a specific command,
the following list might be helpful:

Navigating in the 2D Drawing Area
Adding a Node
Moving Nodes
Adding a Polygon
Applying Textures to Polygons
Removing Nodes and Polygons



Importing the Terrain into UnrealEd

 

3. UnrealPolyEd Windows

 Screenshot: UnrealPolyEd Welcome Screen

The Welcome Screen is usually displayed at startup. It allows you to quickly select the task
to execute or to continue previous work.

 New Terrain Project:  Creates a new terrain project. When clicking this option, a
popup menu with additional options appears:

Single Triangle (three Nodes, one Polygon): Creates just three nodes and one
polygon at the origin to serve as a starting point. This is the default when creating a
new project.

Blank Project: Creates a completely blank project with no nodes or polygons.

Mesh (Quadratic Regular Grid): Creates a mesh consisting of the given number of
columns and rows of polygons. The mesh can be freely deformed afterwards.

 Open Existing Terrain Project:  Opens an existing terrain project from file. When
clicking this option, a popup menu with additional options appears:

Open Other Terrain Project: Lets you browse for an UnrealPolyEd project file to
open.

Recent File List: Shows the name(s) of recently opened projects. The most recently
used file is located at the top. The list is initially populated with the projects from the
examples subdirectory on the UnrealPolyEd installation.

 Getting Started (opens Manual):  Opens this manual in the default web browser.

 Go to the Workspace:  Close the Welcome Screen and directly go to the
workspace.

Do not Show this Dialog at Startup: Check this if the Welcome Screen should not be
shown at UnrealPolyEd startup in the future. If you have selected this option once and



want to get the Welcome Screen back, choose the option ? ? Welcome screen... from the
main menu or press Ctrl+W.

 Screenshot: UnrealPolyEd Main Window

In the following, the individual components of the UnrealPolyEd main window are explained
in detail.

Menu Bar: The menu bar allows invoking various commands with respect to
project management, import/export, addition and removal of objects, view
settings, tools and help.
UnrealPolyEd can load and save projects from/to files with the extension .upp. To

do so, use the Project ? Open..., Project ? Save As... and Project ? Save commands in the
main menu. Alternatively, you may use the  Open  or  Save  tool bar buttons.
In addition, the tools allows exporting the terrain brush in formats that are recognized by
UnrealEd (brush export). Read section Importing the Terrain into UnrealEd for details.

Tool Bar: The tool bar provides quick access to the most common commands
from the main menu bar.

2D Drawing Area: The largest part of the UnrealPolyEd main window is covered
by the 2D drawing area. It has similar characteristics as the top view in UnrealEd.
The screenshot above shows the initial configuration: a single polygon made of
three nodes drawn on a grid with a spacing of 16 units (UnrealPolyEd units are

equivalent to UnrealEd units). The numbers next to the nodes indicate their Z coordinate
(i.e., their absolute height in the world). The shown polygon's bottom left corner, drawn in
red, is the highest part of the polygon, while the top part, drawn in blue, is the lowest
part. If a player would walk on this polygon, he would probably slide down to the blue
area due to the extreme difference in height.
Nodes can be selected by clicking on them. To select multiple nodes, hold the Ctrl key
down while clicking on the nodes. Polygons can be selected by either clicking on the
colored dot in their center or onto one of their edges. Notice however that since
neighboring polygons share edges, you might accidentally select the wrong polygon. In



this case, click on the same edge again to select the other neighboring polygon.
Navigating in the 2D drawing area is similar to moving in a 2D perspective in UnrealEd.
See section Navigating in the 2D Drawing Area for more information.

Popup Menu: The popup menu can be invoked by right-clicking in the 2D
drawing area. The available commands depend on the object(s) being clicked on.

Gradient Panel: In order to visually indicate the slope of the terrain, different
colors are used to represent different Z (i.e., height) coordinates. The gradient
panel, located above the 2D drawing area, illustrates which color corresponds to
which height. The MinZ input to the left of the gradient allows entering the Z

coordinate that corresponds to blue color. Nodes or polygons with an even lower Z
coordinate will be shown in black color. The MaxZ input to the right of the gradient allows
entering the Z coordinate that corresponds to red color. Nodes or polygons with an even
higher Z coordinate will be shown in white color.

 Page Increment (PgInc): Modification of the Z coordinate (height) of a node
works as follows: first select the respective node(s) by clicking on them (possibly
holding down the Ctrl key). Notice that the selected nodes do not have to belong
to the same polygon. Then you have two options: either you use the PgUp (page

up) and PgDown (page down) keys on your keyboard to adjust the height or you use the
mouse wheel while the focus is on the UnrealPolyEd main window. The
increment/decrement applied with every pressing of the key or mouse wheel move can be
adjusted in the "PgInc" input located on the right side above the 2D drawing area.
You can also raise all nodes of one or multiple polygon at once. To do so, select the
polygon(s) by clicking on their centers or edges (possibly holding down the Ctrl key) and
then press the PgUp/PgDown key or move the mouse wheel. The nodes that make up the
polygons will be automatically added to the selection for you in this case.

Show Z: Toggles whether the Z (height) coordinates of all vertexes are always
rendered in the 2D drawing area. If disabled, the Z coordinates are only rendered
for selected nodes.

Status Bar: The status bar provides some read-only information about the state
of the project, the current selection and the current grid size.

 Screenshot: Properties Tool Window

Properties Tool Window: In order to edit the properties of nodes and polygons in
detail, you can double-click in the 2D drawing area to bring up the Properties tool
window. This window is similar to the respective window in UnrealEd.

 Show Nodes: Indicates whether the object selection box should list nodes.
This setting has no effect on the terrain itself; it merely serves as a filter for the
Properties tool window.



 Show Polygons: Indicates whether the object selection box should list
polygons. This setting has no effect on the terrain itself; it merely serves as a
filter for the Properties tool window.

 Group filter: If set to a non-empty value, only objects matching the given
group filter are shown in the object selection box. Group names starting with an
N are defined on nodes, those starting with a P are defined on polygons and
those listed as NP are defined on both nodes and polygons. This setting has no

effect on the terrain itself; it merely serves as a filter for the Properties tool window.

 Object selection box: This box allows selecting a specific node or polygon for
editing its properties. When selecting one or multiple nodes or polygons in the 2D
drawing area, the selection in this box will be updated automatically.

 Property editor: The property editor shows the current values of the
properties for the selected objects. You can edit a value by clicking on the
respective row, just like in UnrealEd. Press the Enter key on your keyboard to
apply the new value. If multiple entities are selected, the common values among

all objects are displayed. Editing a property will apply it to all selected objects in this
case. The following properties are available:

Description ? Group (NP): Optional group name for the selected object(s).
Description ? Name (NP): Optional name for the selected object(s).
Position ? X (N): Horizontal (X axis) coordinate of a node.
Position ? Y (N): Vertical (Y axis) coordinate of a node.
Position ? Z (N): Height (Z axis) coordinate of a node.
Vertexes ? Node1 (P): First vertex index of the polygon (ranges from zero to the
number of nodes minus one).
Vertexes ? Node2 (P): Second vertex index of the polygon (ranges from zero to the
number of nodes minus one).
Vertexes ? Node3 (P): Third vertex index of the polygon (ranges from zero to the
number of nodes minus one).
Display ? Color (P): Optional color to assign to the polygon. Colors are specified
numerically in decimal or hexadecimal ($ prefix) format. The byte order is (from lowest
to highest byte) red, green and blue. For example, $FF is red, $FF00 is green and
$FFFF is yellow. The color is only visible if View ? Gradient lines is disabled in the main
menu. The special color value -1 or $FFFFFFFF disables polygon coloring (i.e., color
always depends on the height of the polygon).
Display ? Texture (P): Specifies the texture to be applied to the polygon in the engine.
Format is PackageName.TextureName, just like in UnrealEd.

If a warning icon is shown in the property editor, hover over the icon to see the reason.
Currently the icon is shown when editing the coordinates of nodes while the Edit ?
Automatically snap X and Y to grid main menu option is active to indicate that the entered
values will be automatically rounded to the next grid coordinate.

 Screenshot: Background Image Dialog



Background Image Dialog: The Background Image dialog, which is accessed via Tools
? Background image... can be used to specify a background image to render in the 2D
drawing area. This feature is useful for displaying a reference image for creating the
terrain, such as a sketch. The controls of the dialog are explained in the following.

Image file: Name of the image file to serve as a reference. The image must be
in .jpg, .jpeg, .png, .bmp, .wmf or .emf format. Leave empty to disable
background image rendering.

Browse: Open a dialog where the image file to use can be chosen.

Origin X/Y: Position in world coordinates (units) where the center of the
reference image is to be rendered. Defaults to 0.0.

Scale W/H: Scale to use along the X and Y axis when rendering the reference
image. Defaults to 1.0.

Preview: Renders a preview of the reference image, if any. If the preview
image is larger than the available space, it will be stretched to fit the area
completely. Notice that the origin and scale values are not applied in the
preview.

 Screenshot: Texture Report Dialog



Texture Report Dialog: The Texture Report dialog, which is accessed via Tools ?
Texture report... displays a list of all textures used in the current terrain, sorted by
package name. The Select button may be used to select all polygons whose texture is set
to the respective package or texture name.

 

4. Common Tasks

Starting a New Project: In order to create a new terrain, select Project
? New from the main menu. Alternatively, use the  New  tool bar
button. If the previously open project has been modified, UnrealPolyEd
will ask you to save it first.

Navigating in the 2D Drawing Area: Navigation in the 2D drawing
area is similar to UnrealEd: left-click and drag to pan the view slowly.
Right-click and drag to pan the view quickly. Hold the left and right
mouse button and move the mouse vertically to zoom in and out. Click on
an object to select it (for polygons, click on the center knob or one of its
edges).

Zooming the 2D Drawing Area to Fit: If you want to adjust position
and zoom of the 2D drawing area to fit all present objects, use the View ?
Zoom to fit main menu option, press Ctrl+M or click the  Zoom to Fit
tool bar button.

Adding a Reference Image: In case you have a sketch of the terrain
you want to create around, you can load it into UnrealPolyEd in order to
save as a reference. To do so, export your sketch as .jpg, .jpeg, .png,
.bmp, .wmf or .emf and then click Tools ? Background image... to bring
up the Background Image dialog. The same can be achieved with the 

 Background Image  tool bar button. Choose Tools ? Clear background
image to hide the reference image.

Undo and Redo: In order to undo a previous action, choose Edit ?
Undo. In order to redo a previously undone action, choose Edit ? Redo. If
you want to undo or redo multiple actions at once, hold the left mouse
button down on the  Undo  or  Redo  tool bar button, respectively,
until a popup menu appears. When selecting an item in the popup menu,



all actions above and left to it are automatically undone/redone as well.
Not all actions can be undone, such as Navigating in the 2D Drawing Area
or exporting the terrain to a file to disk (see Importing the Terrain into
UnrealEd).

Changing Grid Settings: Right-click on the 2D drawing area without
moving the mouse to bring up the popup menu. In the menu, select the
respective item in the Grid submenu to adjust the grid density.
In order to toggle automatic snap-to-grid of nodes, invoke the respective
option in the Edit submenu of the main menu. Alternatively, you can click
on the  Automatically Snap X/Y to Grid  tool bar button. Notice that
enabling this option does not automatically snap all existing nodes to the
grid. See also the Snapping Nodes to the Grid section.

Adding a Node: A new node can be added by either double-clicking on
an empty space in the 2D drawing area or by right-clicking on an empty
space and selecting Add node here. If the Edit ? Automatically snap X and
Y to grid main menu option is active, the nodes will be automatically
snapped to the nearest grid coordinate.

Moving Nodes: To move one or multiple nodes, first select them
(possibly holding down the Ctrl key). For selecting all nodes, use the
Select all option in the Edit submenu of the main menu. Then hold down
the Ctrl key while left-clicking on one of the selected nodes and move the
mouse to move the node(s). If the Edit ? Automatically snap X and Y to
grid main menu option is active, the nodes will be automatically snapped
to the nearest grid coordinate.

Snapping Nodes to the Grid: For snapping selected nodes to the grid,
select the node(s) (possibly holding down the Ctrl key), right-click on one
of the selected nodes and choose Snap to grid from the popup menu.

Hint: For selecting all nodes, use the Edit ? Select all ? Nodes option
in the main menu.

Adding a Polygon: There are multiple ways available to create a
polygon: either you let UnrealPolyEd automatically fill the area in between
three nodes or you specify the nodes that make up the polygon
individually.

Automatic polygon creation: To let UnrealPolyEd create a polygon
for you to fill a gap in your terrain, make sure that you have added at
least three nodes (see section Adding a Node). Then right-click into the
area between the three nodes. In the popup menu, you will see the
options Add ground polygon here and Add sky polygon here. Choose
one of the options depending on the type of polygon you want to
create. UnrealPolyEd will then find the three nearest nodes that do not
yet make up a polygon and create a polygon with the respective
orientation.
Alternatively, you can use the Ctrl+D (ground polygon) and Ctrl+K (sky
polygon) key bindings (see the respective items in the Edit menu).
Notice that the position of the cursor denotes the rough place where to
add the polygon when executing the keyboard commands.

Manual polygon creation: If UnrealPolyEd is unable to detect which
polygon is to be created, you can specify the vertexes to use manually
as follows: select exactly three nodes and right-click on one of the
selected nodes. In the popup menu, you will see the options Add
ground polygon and Add sky polygon. Choose one of the options
depending on the type of polygon you want to create.

Moving Polygons: To move one or multiple polygons, select them by
clicking on their centers or edges (possibly holding down the Ctrl key). To



move the polygon(s), hold the Ctrl key down, hold the left mouse button
pressed while in the 2D drawing area and move the mouse.

Applying Textures to Polygons: Each newly created polygon is
assigned a default texture, namely "GenEarth.Grass". The texture name
is the same as displayed in UnrealEd's texture browser. In order to assign
a different texture, two options exist. First, you can double-click on a
polygon to open the Properties tool window. The texture can be modified
by editing the respective value. Second, if you have already assigned the
needed texture to a different polygon, you can simply right-click on the
polygon and select the respective item in the Apply texture submenu.
See also question How can I obtain a list of all textures used by my
terrain?

Flipping the Polygon Orientation: Polygons can be ground or sky
polygons, depending on whether the player stands on them (ground) or
sees them from below (sky). The current orientation is printed in square
brackets when the polygon is selected; it reads either [ground] or [sky].
If you want to flip the orientation of one or multiple polygons, select
them first (possibly holding down the Ctrl key) and then choose one of
the following options: right-click on one of the selected polygons (not on
a node) and select Flip polygon orientation, invoke the same command
from the Edit main menu or press Ctrl+F. See also question My brush
seemed to import fine into UnrealEd, but after subtracting, it has holes or
is not visible at all?

Removing Nodes and Polygons: In order to delete one or multiple
nodes and/or polygons, select them first and then right-click on one of
the selected objects and choose Remove selection. Alternatively, choose
the Edit ? Remove selection main menu command, click on the 

 Remove Selection  tool bar button or press the Del key.

Importing the Terrain into UnrealEd: In order to import the terrain
into UnrealEd, you first have to convert the UnrealPolyEd project to a file
format that is shared with UnrealEd. For this purpose, UnrealPolyEd
supports exporting the terrain as a .t3d file. To export, click on Project in
the main menu and select Export or click the  Export  tool bar button.
In the dialog box, choose Unreal Text (*.t3d) and click Export.... Choose
a name for the exported file.
In order to import the .t3d file in UnrealEd, choose Brush from
UnrealEd's main menu, choose Import... and select the file you just
exported. In the Import Brush dialog, you should typically leave the
default settings (i.e., don't merge faces and solid mesh). The red builder
brush should now have the shape of the terrain modeled in UnrealPolyEd.
Before subtracting the brush from the world, make sure that you load
the required texture packages, because UnrealEd won't automatically
load them for you. See Why do I see the white "mildew" texture on my
terrain? for more information.

Hint: If you have previously exported the terrain to a file for a given
UnrealPolyEd project, you can also choose Project ? Export again to
export the terrain once more using the same format to the same file.

Importing and Exporting Terrain Data: Sometimes it is useful to
import/export the coordinates of nodes from/to file. This can be achieved
with the Project ? Import..., Project ? Export... and Project ? Export again
main menu options and the respective tool bar buttons  Import  and 

 Export .

Adjusting Display Settings: The View menu offers various options for
tuning the visual representation of the UnrealPolyEd main window and the
2D drawing area that are explained in the following.



Tool bar: Toggle display of the tool bar on and off.

Gradient panel: Toggle display of the gradient panel (including MinZ,
MaxZ, PgInc and Show Z controls) on and off.

Status bar: Toggle display of the status bar on and off.

Gradient lines: Draw polygon lines in color gradients to accurately
represent the Z coordinate. Enabling this option may affect rendering
performance.

Show node names: Show the names of all nodes in the 2D drawing
area. If this option is disabled, names are only shown for selected
nodes.

Show Z coordinates: Show the Z coordinates of all polygons in the
2D drawing area. If this option is disabled, Z coordinates are only
shown for selected polygons.

Show polygon names: Show the names of all polygons in the 2D
drawing area. If this option is disabled, names are only shown for
selected polygons.

Show texture names: Show the texture names of all polygons in the
2D drawing area. If this option is disabled, texture names are only
shown for selected polygons.

Show position: Render position information in the top left corner of
the 2D drawing area. For debugging purposes only.

Show scale: Render the current scale (zoom factor) in the top left
corner of the 2D drawing area. For debugging purposes only.

Show log: Show or hide the UnrealPolyEd command log window.

Show properties: Show or hide the Properties Tool Window. Same as
the  Properties  tool bar button.

Automatically show properties: If enabled, the Properties Tool
Window is automatically shown depending on the current selection in
the 2D drawing area.

Opening the Manual: In order to open this manual from within
UnrealPolyEd, choose the ? ? Manual option in the main menu or click
then  Manual  tool bar button.

 

5. Key Bindings

Project
Management,
Import and
Export

Ctrl+W
Show
Welcome
Screen

Ctrl+N New Project

Ctrl+O Open
Project

Edit, Undo and Redo

Ctrl+Z Undo
Ctrl+Y Redo

Ctrl+G Toggle Auto-Snap
X and Y to Grid

Ctrl+D Add Ground
Polygon

Ctrl+K Add Sky Polygon

Ctrl+F Flip Polygon

View and Zoom

Ctrl+M Zoom to Fit

Ctrl+R Show
Properties

Alt+I Edit MinZ
Alt+A Edit MaxZ
Alt+P Edit PgInc
Alt+Z Toggle Show Z



Ctrl+S Save
Project

Ctrl+I Import
Ctrl+E Export

Ctrl+X Export
Again

Alt+F4 Quit

Orientation
Ctrl+A Select All
Del Remove Selection

PgUp Raise Selected
Nodes by PgInc

PgDown Lower Selected
Nodes by PgInc

Tools

Ctrl+B Background
Image Settings

Ctrl+U Texture Report

Help

F1 Show Manual

 

6. Frequently Asked Questions (FAQ)

 Why do I see the white "mildew" texture on my terrain? This
happens in the following two cases: either you have not assigned a valid
texture to the respective polygon or you have applied (i.e., subtracted or
added) the terrain brush in UnrealEd without previously loading the
required texture packages. Unfortunately, UnrealEd does not load the
texture packages automatically for you. For example, if your terrain has
the GenEarth.Grass texture applied (see section Applying Textures to
Polygons), fire up the texture browser in UnrealEd and load the GenEarth
texture package. Repeat this step for every texture package. You only
need to do this only once after you started UnrealEd and only if the
loaded map does not require the respective textures to be loaded. Only
after doing that, subtract or add the brush from/to the world.
See also question How can I obtain a list of all textures used by my
terrain?

 My brush seemed to import fine into UnrealEd, but after
subtracting, it has holes or is not visible at all? Double-check that the
polygons of your terrain have the correct orientation. As a first guess,
you might want to fly underneath your terrain to check whether the
respective polygons are visible from below. If this is the case, then you
need to flip the orientation of the respective polygon(s) in UnrealPolyEd
and import the terrain again into UnrealEd. In UnrealPolyEd, select the
polygon(s) in question and then pay attention to the text displayed in the
polygon(s). If you read "[sky]", but you actually want the polygon(s) to
form the ground, right-click on the polygon(s) and select Flip polygon
orientation. Now the respective text should read [ground]. Flipping the
orientation again will get you back to [sky].
After having done this, follow the steps from section Importing the
Terrain into UnrealEd to import the terrain again into UnrealEd.

 How can I obtain a list of all textures used by my terrain? You can
choose Tools from UnrealPolyEd's main menu and select Texture report...
to list all the textures (and texture packages) required to correctly
import your terrain into UnrealEd. Remember to load these texture
packages before applying (i.e., subtracting or adding) your brush from/to
the world or you will otherwise see the white "mildew" texture on your
terrain.
See also question Why do I see the white "mildew" texture on my
terrain?



 

7. Changelog
Version 0.7 (2014-04-21):

New: Experimental support for importing .t3d files exported via
UnrealEd's File ? Export

New: Allow to deselect objects by clicking again on them while holding
down Ctrl

New: Highlight active grid setting in popup menu
New: Examples now ship with exported .t3d files
Fixed: "New" tool button doing nothing
Fixed: Assertion failure in conjunction with node selection and redo
Fixed: Unintended view pan when right-click, then left-click or right-click

somewhere else
Fixed: Selection of individual polygons in Texture Report form not

working

Version 0.6 (2014-03-15):

New: Install and uninstall support
New: Undo/redo support
New: UPE-specific icon
New: Welcome screen on startup
New: Background image support
New: Texture report support
New: Extensive manual (this document)
New: Example projects
New: Automatic polygon creation algorithm ("Add ground/sky polygon

here" command)
New: "Export again" support when previously exported
New: "Zoom to fit" support
New: Many more commands in tool bar
New: Show polygon orientation (ground/sky) for selected polygons
New: Allow to set focus on 3D drawing area
New: Draw frame around 2D drawing area when focused
New: "Remove selection" command in main menu (Del key)
New: "Add ground/sky polygon" command in main menu
New: Option to hide "gradient panel"
New: Move selected polygons (including their vertexes) when holding

down Ctrl and moving the mouse
New: Enter in property editor applies new value
New: "Flip polygon orientation" command in main menu and popup

menu
New: "Snap to grid" options for Z axis
New: Double-click in 2D drawing area to add node
New: Status bar shows selection statistics (nodes/polygons)
Changed: Polygons are now created by selecting three nodes as opposed

to selecting the nodes one after another
Changed: Project default settings (MinZ, PgInc, Grid)
Changed: Height of nodes created by default when creating new project
Changed: Removed obsolete "Edit polygon" command
Changed: Do not enable "Show position" and "Show scale" by default
Fixed: Bad performance with gradient lines at high zoom factors
Fixed: Disallow entering of invalid node indexes for polygon vertexes
Fixed: Esc key dismisses dialog windows

Version 0.5 BETA (2014-02-19):



New: Start new projects with three nodes and one ground polygon
New: Grid support
New: Snap to grid support
New: Option to render polygon lines as color gradients
New: Option to always show texture names
New: Added "center handles" to polygons to allow easier selection and

detection of holes
New: "Remove polygon" command in popup menu
New: Allow to use mouse wheel to raise/lower selected polygons/nodes
Fixed: Unable to remove nodes

Version 0.4 BETA (2014-02-15):

New: English translation
New: Options to always show node and polygon names
New: Highlight selected polygons more clearly
New: Tutorial video of German version

Version 0.3 BETA (2003-03-09):

New: First public release

 

8. Contact Information, Copyright and License
Contact information:

Homepage: http://www.sidewinder.de.vu/
E-Mail: Sidewinder_GER@hotmail.com

Copyright:

Copyright © 2000-2014 by Michael 'Sidewinder' Geisinger, all rights
reserved.

For updates, please check my website or send me an e-mail with subject
"UnrealPolyEd". Suggestions for improvements, bug reports and reports on
how and for which purpose you are using UnrealPolyEd are of course also
welcome!

License:

"Author" herein refers to Michael 'Sidewinder' Geisinger, the creator of
UnrealPolyEd. "Software" refers to all content included with UnrealPolyEd.

The Software is being distributed as freeware. Use and distribution of the
Software is permitted provided that all of the following terms are accepted.

The Author grants you a non-exclusive license to use the Software subject
to your compliance with all of the terms and conditions of this license.
The Software is provided "as-is," without any express or implied warranty,
without even the implied warranty of merchantability and fitness for a
particular purpose. In no event shall the Author be held liable for any,
direct or indirect, damages arising from the use of the Software.
All redistributions of the Software's files must be in their original,
unmodified form. All redistributions of the Software must retain all

http://www.sidewinder.de.vu/
mailto:Sidewinder_GER@hotmail.com


copyright notices and must include this list of conditions without
modification.
None of the Software's files may be redistributed for profit or as part of
another software package without express written permission of the Author.
Use of the Software within the scope of this license is free of charge and no
royalty or licensing fees shall be payable by you.
The Author reserves his rights to modify this agreement in the future.

Third-party components:

UnrealPolyEd uses TPNGImage by Gustavo Daud.

mailto:gubadaud@terra.com.br
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